
(This document is the Getting Started Guide for the Conversa' Web ToolKit.  It is not done, obviously.  Parts that need to be completed are highlighted using bold text.  If you are reviewing this document, please address all concerns to Alex Thayer, x238.)

Chapter 1 - Introduction

This guide is an introduction to the Conversa' Web ToolKit.  The ToolKit is a software application that combines several Web development features within a graphical interface.  This interface provides an easy-to-use tool with which Web site developers can “conversationalize” their Web sites.

About this guide

This guide contains information about the following topics:

· Installing the ToolKit

· Understanding the concept of the “conversation” and the      conversationalized Internet

· Using the function of the ToolKit

· Troubleshooting

Once you have read this document, you will be familiar with the function of the Conversa' Web ToolKit and its importance in relation to the future of the Internet.

The information in this document is separated into the following chapters:

· Chapter 1 - Introduction.  This chapter describes the contents of the guide.

· Chapter 2 - Installing the ToolKit.  This chapter contains installation instructions for the ToolKit.
· Chapter 3 - Using the ToolKit.  This chapter describes how to use the graphical interface that contains the ToolKit function.

· Chapter 4 - Conversationalizing the Internet.  This chapter contains conceptual information about conversations and their place on the Internet.
The companion guide to this document is the Conversation Creation Guide (CCG).  The CCG contains information regarding the creation of conversations: how to create conversations, how the code of the conversations functions, and more.  Please refer to that guide for detailed information about conversation planning and creation.

Who can use this guide?

This document is primarily targeted at software and Web site developers.  However, anyone with basic knowledge of computing and of the Internet can understand the information in this document.  The term “basic knowledge” refers to the following general areas of computer operation:

· Navigation of the Windows 95/98 and Windows NT operating systems

· Navigation of the Internet using a Web browser such as Conversa' Web or Microsoft Internet Explorer

· Use of the mouse (or other pointer device) and keyboard

· Familiarity with the simple commands of a graphical user interface (GUI), such as the Open, Save, and Undo commands

If you already possess this knowledge, the directions in this document will be easy to follow.  However, you do not have to be a computer expert to understand the concepts contained in this document.  For conceptual information, please refer to Chapter 4 - Conversationalizing the Internet.

Style conventions 

Throughout this guide, several different typefaces and typeface styles are used.  This section lists each font used in the ToolKit documentation, including examples of font usage.

Times New Roman

This font is used for:

· Action text, 12-point bold (used to describe procedures)

· Caption text, 12-point bold (used for figures, tables, and examples)

· HTML Tag text, 12-point capitalized (when referenced from within the body text

· Level 4 heading text, 12-point italicized

· Normal text, 12-point

· Ordered list heading text, 16-point bold

Arial

This font is used for:

· Level 1 heading text, 16-point bold

· Level 2 heading text, 14-point bold italicized
· Level 3 heading text, 12-point bold

Courier New

This font is used for:

· Function() names, method() names, and class names referenced from within the body text, 12-point

· Sample Code text, 12-point

· Variable text referenced from within the body text, 12-point

ToolKit package contents

The ToolKit package contains the following items:

· Full copy of Conversa Web 3.0

· Additional Tools/Utilities/Sampler CD with online documentation

· Getting Started guide (this manual)

· Sampler to include working/cached versions of various conversations

· White Paper: “Conversationalizing the Internet/Intranet with Conversa Web”

If your package did not come with all of these items, refer to the section named Contacting Conversa' in this chapter.

System requirements

The Conversa' Web ToolKit currently operates under Macromedia Dreamweaver; therefore, you must have Macromedia Dreamweaver 2.0 installed on your machine when you install the ToolKit.  The system requirements for Macromedia Dreamweaver are:

· Intel Pentium processor or equivalent 90+ MHz

· Windows 95/98 or NT version 4.0 or later

· 32 MB RAM

· 20 MB of available disk space

· 256-color monitor capable of 800x600 resolution

· CD-ROM drive

These requirements are the same as those of the ToolKit.

Registration

How to register the product

Contacting Conversa'

Tech support numbers/web addresses/mailing address/whatever is required

Chapter 2 - Installing the ToolKit

This section describes the ToolKit installation process.  For a list of system requirements, refer to the System requirements section in Chapter 1 - Introduction.  Before you can install the ToolKit, you must have Macromedia Dreamweaver (version 2.0 or higher) installed on your computer.  If you do not have Macromedia Dreamweaver, visit the Macromedia Web site at: http://www.macromedia.com.


Rest of instructions go here.

Chapter 3 - Using the ToolKit

The Conversa' Web ToolKit is comprised of several META objects and JavaScript-based behaviors; using Macromedia Dreamweaver, you add these objects and behaviors to a Web page.  

Objects

The ToolKit includes several objects that, when added to a Web page, extend the conversational function of that page.  Most of these objects are simply META tags that the Conversa' Web browser interprets when it opens a Web page containing the tags.  The remaining objects are more complex than the META elements; each function is described in detail later in this section.  The available functions are as follows:
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Insert Conversational Window: this icon creates a new conversation window.  The conversation window contains the voiceable commands of a conversation.

Insert Conversa Java Client: this icon inserts the Conversa' Java Client applet.  This applet facilitates repeated text-to-speech playback.

Insert PlayAudio Meta: this icon inserts a WAV file that will be played when the Web page loads.

Insert PlayTTS Meta: this icon inserts text that will be converted into speech and played back over the computer speakers.

Insert Voice-Friendly Meta: this icon inserts an object that directs the Conversa' Web browser to trust the ALT tag contents of the page.  Saycons will not appear on a page that has this object inserted, as long as ALT text is present.

Insert Random PlayAudio Meta: this icon inserts an object that randomly plays WAV files that you specify (WAV files are played when the Web page loads).

Insert Random PlayTTS Meta: this icon inserts an object that randomly plays text as speech; you specify the text (speech is played when the Web page loads).



Figure 1: List of Conversa Object icons

You can access the ToolKit objects from within the Objects window or through the Insert menu.  To access the ToolKit objects from within the Objects window, follow these steps:

Step 1:

Select Window -> Objects.  The Objects menu appears (Figure 2 shows the Common Objects):


Step 2:

Using the pull-down menu located near the top of the Objects window, select Conversa:


Step 3:

The Conversa Objects menu will appear (these icons are described in detail later in this chapter):
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Figure 2: Common Objects menu
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Figure 3: Common Objects menu with Conversa selected
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Figure 4: Conversa Objects menu

Each of the objects is also available in the Insert menu.  To access these objects from the Insert menu, select Insert -> Conversa Object.  You will see the same list of ToolKit objects; however, these objects are only referenced by name in the Conversa Object menu.  The menu looks like this:
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Figure 5: Insert Conversa Object menu

These objects provide the same function regardless of where you choose to access them.  The names within this menu also apply to the list of buttons contained within the Conversa Objects window. 

Insert Conversational Window

The first ToolKit object is the Insert Conversational Window object (see Figure 1 for a picture of the icon).  Within a Web site, the conversational window is the portion of the screen that contains the majority of the conversationalized content.  When you select the Insert Conversational Window object, the following screen appears (presented as Figure 6):
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Figure 6: Insert Conversational Window screen

Within this screen, you can adjust the properties of the conversational window before the window is inserted into your Web page.


The Window Name property defines the name of the conversational window you are creating.  In Figure 6, the name of the conversational window is defined as “My window.”  This name will only appear within the HTML code for the Web page; you will not see this name within your Web browser.


The Size property sets the number of pixels the conversational window will be.  This property works in conjunction with the Position property; the Position property defines the location of the conversational window within the Web page.  For example, in Figure 6 the window will be embedded on the left side of the page; the window will be 200 pixels wide.  Finally, the File Name property defines the file that will be loaded into the conversational window.  In Figure 6, this field is left blank.


When you create a conversational window, you will see a question mark icon within Dreamweaver’s Head Content window.  This icon is visible in Figure 7 (shown below):
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Figure 7: Head Content window with conversational window icon

Figure 7 shows the Menu bar and Head Content window within Macromedia Dreamweaver.  The conversational window appears as a question mark within the Head Content window.  If you do not have the Head Content window open, select View -> Head Content to open the window.  When you double-click on the question mark icon, the Properties window automatically appears; this window contains the properties of the conversational window.  Figure 8 shows the Properties window that corresponds to the text used in Figure 6:
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Figure 8: Properties window for the conversational window

You can adjust the window name, size, location, and initial content of the conversational window within the Properties window.  Because the File Name property was left blank in Figure 6, the text “User left blank” appears in the File Name text box within Figure 8.


You cannot have more than one conversational window within the same page.  Therefore, you will receive the following error if you try to insert another conversational window object:
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Figure 9: Conversational window error message

This error message also describes how to view the Properties window associated with the conversational window.

Insert Conversa Java Client

The Insert Conversa Java Client object inserts an applet into a Web page (see Figure 1 for a picture of this object’s icon).  You must include this applet within a page if that page contains JavaScript audio functions.  These functions are described in the Behaviors section within this chapter.


When you insert the Conversa Java Client object, an applet icon will appear within the body of your Web page; Figure 10 is an enlarged representation of this icon:
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Figure 10: Conversa Java Client applet icon

If you double-click on this icon, the Properties window will display the properties of this applet.  However, you should not alter the properties of this applet; it is not visible within the page.  This applet runs in the background; it facilitates repeated text-to-speech and audio file playback within a Web page.

Insert PlayAudio Meta

This object inserts an instance of the PlayAudio META element into the head of the page (see Figure 1 for a picture of this object’s icon).  This element plays a specified WAV file as soon as the Web browser has opened the page.  Because this WAV file is referenced using a META element, the Conversa Java Client applet is not required.  


When you select the PlayAudio Meta object, the following screen appears (shown here as Figure 11):
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Figure 11: Insert PlayAudio Meta screen

Within this screen, you can select the WAV file that the META element will reference when it is loaded.  Click on the Browse button to select a file from the list of available files and folders.


After you insert an instance of the PlayAudio Meta object, the object will be visible within the Head Content window.  This object is represented graphically as a META element (the icon resembles a clipboard).  You can insert as many of these objects as you want; there are no limitations on the number of PlayAudio Meta objects you can insert into a page.

Insert PlayTTS Meta

This object is similar to the PlayAudio Meta object (see Figure 1 for a picture of the corresponding icons).  The difference is the type of input you provide: with the PlayTTS Meta object, you enter text that will be converted into speech.  When you select the PlayTTS Meta object, the following screen appears (shown as Figure 13):
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Figure 12: Insert PlayTTS Meta screen

When the screen in Figure 12 opens, the cursor will be located inside the large text box.  This box is where you enter the text you want to convert into speech.  Figure 13 (shown below) contains the example sentence, “This is a test.”  
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Figure 13: Insert PlayTTS Meta screen with sample text

The text shown in Figure 13 will be spoken to the user when the Web page containing this META element is opened.


The PlayTTS Meta object includes three Java Speech Markup Language (JSML) attributes that you can adjust.  These three attributes are:

· Pitch: this attribute changes the pitch of the spoken words; you can make the voice sound lower or higher than normal by adjusting the value of this attribute.

· Rate: the value of this attribute increases or decreases the speed of the spoken words; higher values force faster playback of the text.

· Volume: this attribute changes the volume of the spoken words; you can make the voice sound louder or softer than normal by adjusting the value of this attribute.

To adjust the values of these attributes, click on one of the JSML buttons.


Figure 14 (shown below) continues the example started in Figure 13.  In Figure 14, the pitch attribute has been selected.  Notice how there are HTML tags inserted around the example sentence (“This is a test”).  The JSML element surrounds the sentence, while the PROS element is included after the sentence.
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Figure 14: Insert PlayTTS Meta pitch example

In Figure 14, the value of the pitch has not been specified.  Note the underscore within the PROS tag: you must remove this underscore character and replace it with a numeric value.  Figure 15 (shown below) continues the “This is a test” example; in this case, the pitch value has been set to 200% above the normal value.
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Figure 15: Insert PlayTTS Meta pitch value example

When the text shown in Figure 15 is played back by the Conversa' Web browser, the pitch of the voice will be twice as high as normal.


You can adjust multiple JSML attributes for the same sentence.  To add another JSML attribute, simply click on the corresponding button.  For example, Figure 16 (shown below) contains the same example sentence from Figure 15; however, in Figure 16 the rate attribute has been added to the sentence.
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Figure 16: Insert PlayTTS Meta pitch value and rate value example

In Figure 16, the rate has been set to 50% of its normal value, while the pitch is twice its normal value.  The PlayTTS Meta object will automatically place the HTML tags around the text that you enter into the text box.

Insert Voice-Friendly Meta

This object inserts an instance of the VoiceFriendly META element into the head of the document (see Figure 1 for a picture of this object’s icon).  This object contains no attributes or values to be specified; you only need to insert one instance of this element into a Web page. When this META element is present within a page, the Conversa' Web browser converts the alternate text of the Web page into voiceable links.  In other words, the VoiceFriendly META element removes the yellow Saycons from a page, allowing you to speak a link as it appears without relying on numbered Saycons.

Insert Random PlayAudio Meta

This object inserts a JavaScript function into the head of your Web page (see Figure 1 for a picture of this object’s icon).  This JavaScript function randomly plays one of the files from a list of WAV files that you specify.  Figure 17 (shown below) illustrates the screen that appears when you select the Random PlayAudio Meta object.
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Figure 17: Insert Random PlayAudio Meta screen

When you enter a WAV file name and press the Add button, the WAV file is added to the list (the text box named “Audio files”).


Figure 18 (shown below) contains the same Random PlayAudio Meta object screen; however, in Figure 18 three WAV files have been added to the list of files:
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Figure 18: Insert Random PlayAudio Meta screen with WAV files added

The three WAV files (sample.wav, sample2.wav, and sample3.wav) are now included within the JavaScript function; each of these files can be called at random.  You can also use the Browse function to search for WAV files; the Auto-add browsed filenames checkbox provides the option of automatically adding those files you select while browsing.  If you want to remove a specific WAV file from the list, simply highlight it and delete it.


The Random PlayAudio Meta object is similar to the Voice-Friendly Meta object in one important way: you do not need to adjust the properties of either of these objects.  Unless you are familiar with JavaScript, you do not need to change the JavaScript function that performs the random selection and playback of the WAV files.  Because this object is located within the head of the Web page, you do not need to insert the Conversa Java Client applet.

Insert Random PlayTTS Meta

This object is nearly identical to the previous object; instead of specifying WAV files to be played randomly, you specify text that will be played randomly (see Figure 1 for a picture of this object’s icon).  There are only a couple of minor differences in the JavaScript functions that perform each of the random objects’ functions.  Figure 19 (shown below) depicts the screen that appears when you select the Random PlayTTS Meta object:
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Figure 19: Insert Random PlayTTS Meta screen
To add text to the list of text strings, simply enter the text and click on the Add button.  The text is then displayed in the list (labeled “Strings”).

Figure 20 (shown on the following page) shows the object window after two text strings have been added to the list (the example text strings are “This is another test” and “This is yet another test”).
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Figure 20: Insert Random PlayTTS Meta screen with example sentences

To remove a text string from the list, simply highlight the text you want to remove and delete it.

You can also adjust the values of the JSML attributes of a text string.  For example, to change the value of the pitch attribute of a text string, click on the Pitch button.  The JSML and PROS tags associated with the pitch attribute will appear around the text string.  You can only change the JSML attributes of a text string before you add it to the list; Figure 21 (shown on the following page) includes the pitch attribute around a sample text string.  In Figure 21, the value of the pitch attribute has been changed to 50%, making the pitch twice as low as normal.
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Figure 21: Insert Random PlayTTS Meta screen with pitch attribute added

When you add a JSML attribute to a text string, you will have to manually specify the value of the attribute.  In Figure 21, the value of the pitch attribute has been set to 50%; see the Insert PlayTTS Meta section for information about changing the attribute values.


Once you have added a JSML attribute to a text string, click on the Add button to move the text string into the list of strings.  The JSML and PROS tags will accompany the text string when you move the string into the list.  Figure 22 (shown on the following page) depicts three example sentences within the text string list.  The third sentence, “This is still another test,” contains the pitch attribute and a value of 50%.
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Figure 22: Insert Random PlayTTS Meta screen with JSML attributes added to list

In Figure 22, the JSML attribute changes will affect only one text string; the first two text strings will sound normal upon playback.

In addition to META objects, the ToolKit can also associate specific behaviors with images, links, and other page elements.  These behavioral actions are performed using JavaScript and are not confined to the head of the Web page.

Behaviors

The Conversa' Web ToolKit includes four JavaScript-based behaviors that can be used to modify graphics, links, or other items within a Web page.  The actions that these behaviors perform are static; however, you can control when these actions occur (when you click on a link, for example).  JavaScript event handlers provide this control; the Conversa Behaviors are referenced using JavaScript event handlers.

Event handlers

Event handlers (or “events”) are JavaScript properties that you can associate with nearly any element within a Web page.  JavaScript events tell the Web browser to perform an action when a certain type of user activity occurs.  In Figure 32, the onClick event is associated with the Conversa – Play an audio file action.  The onClick event tells the Web browser to perform an action when you click on the first link within the sample Web page.  But what action will be performed?

Figure 30 and Figure 32 show not only the type of event associated with the first link in the sample Web page, but the action that event will perform.  As you can see from these figures, the onClick event refers to the Conversa – Play an audio file action.  Therefore, when you click on the link that is associated with this event, the Conversa – Play an audio file action will begin playing the WAV file you specified.  As the Web page developer, you control the placement and actions associated with the events.  But how will the end user view your Web page?

The event handlers themselves are not visible to the users viewing your Web page; event handlers are JavaScript code contained within the HTML code of the Web page.  The actions that the events call are noticeable: you want the actions to be noticed.  For example, when you view the sample Web page in a Web browser, you will see three links and a graphic.  The first link has an action associated with it; when you click on the first link, the browser plays a WAV file.  This WAV file could be a description of a product, a voice message, or anything else you want to include.

JavaScript events provide the connection between Web pages and behaviors.  There are several different types of events; Figure 32 shows a list of the other available events.  You can associate any of these events with the Conversa Behaviors provided with the ToolKit.

Figure 23 (shown on the following page) contains brief descriptions of each of the four Conversa Behaviors.  Unlike the Conversa Objects included with the ToolKit, the Conversa Behaviors are not accessible through the Dreamweaver menu bar.  These behaviors are only accessible through the Macromedia Dreamweaver Behaviors window; follow this process to access the Conversa Behaviors:

1. If you do not have the Behaviors window open, select Window -> Behaviors to open the Behaviors window.

2. Click on the plus sign within the Behaviors window to view the list of available behaviors.  All of the Conversa Behaviors are prefaced with the word “Conversa.”

The image in Figure 23 shows the menu that appears when you click on the plus sign icon within the Behaviors window.
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Figure 23: List of Conversa Behaviors

Figure 23 also shows a list of the other behaviors included with Macromedia Dreamweaver.  All of these behaviors are based in JavaScript; refer to the Dreamweaver online help system for more information about Dreamweaver behaviors.

Play an audio file

This behavior associates a WAV file with an item on a Web page.  To get a better understanding of how this behavior works, look at the sample Web page shown in Figure 24 (located on the following page).  Figure 24 contains three links and one graphic:
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Figure 24: Sample Web page

This extremely simple Web page contains four elements, all of which can have actions associated with them.  The Conversa - Play an audio file behavior associates a WAV file with nearly anything within a Web page (including the page itself).  For example, you could associate a WAV file with one of the three links shown in Figure 24.  The process on the following page explains how to perform this task (this process uses the sample Web page pictured in Figure 24):

Step 1

Highlight the link with which you want to associate a WAV file.  
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Figure 25: Behavior association process, link selection

Notice the highlighted link contains the text, “This is a sample link.”



Step 2

From the list of behaviors, select the behavior named Conversa – Play an audio file.
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Figure 26: Behavior association process, behavior selection

When you select this behavior, the following window appears (Figure 27 is an enlarged version of the window; Figure 28 shows the same window within the context of Macromedia Dreamweaver):
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Figure 27: Behavior association process, behavior window (enlarged)
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Figure 28: Behavior association process, behavior window (in context)



Step 3

Enter a WAV file name in the text box provided and click OK (click the Browse button to search for a WAV file).

If you have not added the Conversa Java Client applet to your Web page yet, you will receive a warning message.  This message is reproduced in Figure 29 (shown below):
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Figure 29: Behavior association process, applet warning message

When you click OK, the applet will appear as an icon below the last link on your Web page.  This difference is apparent in Figure 30 (shown on the following page); compare Figure 30 to Figure 25.
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Figure 30: Behavior association process, applet added to sample Web page



Step 4 (optional)

To change the event that triggers the action associated with the link, click on the arrow button located in the Behaviors window (the location of this button is emphasized in Figure 31):
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Figure 31: Behavior association process, changing the event

Click on this arrow to view a list of possible events (as shown in Figure 32):
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Figure 32: Behavior association process, event menu



You can associate any of these events with the Conversa Behaviors; changing the event does not affect the selected action.


Once you have associated a behavior with an object in your Web page, the behavior and its event handler will be visible in the Behaviors window.  You can always change the event or the action after you have established a behavior.  Within the Behavior window, double-click the action to edit the name of the WAV file that is being referenced.  If you want to remove a behavior, select it and press delete.

Conversa – Play random audio file

This behavior is similar to the previous behavior: you can associate WAV files with any Web page element using this behavior.  When you select this behavior, you will see a dialog box (shown in Figure 33 on the following page).  This dialog box is the same as the dialog box shown in Figure 17; please refer to the section named Insert Random PlayAudio Meta for instructions regarding this dialog box.
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Figure 33: Conversa - Play random audio file dialog box

The best way to learn how to use the Conversa Behaviors is by example.  In the previous section, you learned how to associate a specific WAV file with a Web page element.  This section refers to the sample Web page (shown in Figure 24) to demonstrate the Conversa – Play random audio file behavior.  


The following process describes the steps involved with the association of the Conversa – Play random audio file behavior with the second link in the sample Web page.  Before you follow this process yourself, make sure you have the Behaviors window and the Objects window open in Dreamweaver.  This process also includes an extra step that changes the event handler from onClick to onMouseOver.  The onMouseOver event handler performs its associated action when you move the cursor over the Web page element that uses the event handler.  

Step 1

Highlight the link with which you want to associate a WAV file.  
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Figure 34: Random audio file association process, link selection

Notice the highlighted link contains the text, “This is another sample link.”



Step 2

From the list of behaviors, select the behavior named Conversa – Play random audio file.
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Figure 35: Random audio file association process, behavior selection

When you select this behavior, the following window appears (refer to Figure 33 for an enlarged version of the window):
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Figure 36: Random audio file association process, behavior window



Step 3

Enter a WAV file name in the text box provided and click the Add button (click the Browse button to search for a WAV file).  
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Figure 37: Random audio file association process, file name specification

Figure 37 shows the behavior window after one WAV file has been added.  This WAV file is named “first.wav”.  When you click the Add button, the file name is added to the list of audio files; notice the file name also remains in the text box (the text box next to the Add button).  You can add as many WAV files as you want; Figure 38 shows the same behavior window after another WAV file (“second.wav”) has been added to the list.
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Figure 38: Random audio file association process, multiple file name specification

The sample Web page already contains the Conversa Java Client applet; therefore, you will not receive a warning message regarding this applet.  Refer to Figure 29 for a picture of this warning.



Step 4

After you have filled out the list of audio files, click OK to proceed.  Figure 39 (shown below) illustrates what the screen will look like after you click OK.
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Figure 39: Random audio file association process, file list completed

As you can see in Figure 39, the link you modified is still highlighted.  You can also see that a behavior is now associated with this link; the Behaviors window lists all of the behaviors associated with a specific page element.  The next step is to change the type of event associated with the highlighted link.  However, before you can change the event type, you need to make sure the event you want to change is highlighted within the Behaviors window (this action is already complete in Figure 39).



Step 5

Click on the down arrow located within the selected behavior (Figure 40 depicts the proper result of this action):
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Figure 40: Random audio file association process, changing the event handler type

You will see a list of available events; in this example, the onMouseOver event will be used (this event is the eighth event in the list of nine).



Step 6

Click on the event named onMouseOver.  Figure 41 (shown below) illustrates the result of this action:
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Figure 41: Random audio file association process, event handler selection results



When you change the event type of a page element, the element becomes deselected.  You can see in Figure 41 that the second link is no longer highlighted; however, the cursor is located somewhere within the link text (the cursor is not visible in Figure 41).

Conversa – Say a sentence

This behavior allows you to specify text that will be converted into speech when a specific event occurs within your Web page.  When you select this behavior, you will see the following window (shown here as Figure 42):
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Figure 42: Say a sentence text definition window

The window shown in Figure 42 contains a text box named “String.”  You can only enter one text string into this text box; the Conversa – Say a sentence behavior does not support multiple text strings.  However, you can associate multiple behaviors with the same page element.


The following process describes how to associate two text strings with the third link in the sample Web page.  The first string will use onMouseOver as its event handler, while the second text string will use onClick.

Step 1

Highlight the link with which you want to associate a text string.  
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Figure 43: “Say a sentence” association process, page element selection

Notice the highlighted link contains the text, “This is yet another sample link.”



Step 2

From the list of behaviors, select the behavior named Conversa – Say a sentence.
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Figure 44: “Say a sentence” association process, behavior selection

When you select this behavior, the following window appears (refer to Figure 42 for an enlarged version of the window):
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Figure 45: “Say a sentence” association process, behavior window



Step 3

Enter a text string in the text box provided and click OK (if you want to change the JSML properties of the text string, do not click OK until after you adjust the JSML values).  Figure 46 shows the behavior window before OK is clicked:
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Figure 46: “Say a sentence” association process, file name specification

Figure 46 shows the behavior window after a text string has been entered, but before OK is clicked; the text string is “Click on this link.”.  If you want to change the JSML properties of this text string, follow the directions listed in the section named Insert PlayTTS Meta (though that section describes a META element instead of a JavaScript behavior, the JSML instructions are the same).



Step 4

Click on the down arrow located within the selected behavior (Figure 47 depicts the proper result of this action):
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Figure 47: “Say a sentence” association process, changing the event handler type

You will see a list of available events; in this example, the onMouseOver event will be used (this event is the eighth event in the list of nine).



Step 5

Click on the event named onMouseOver.  Figure 48 (shown below) illustrates the result of this action:
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Figure 48: “Say a sentence” association process, event handler selection results

Now that the first behavior is now added, you can add the second behavior.  This process is nearly identical to the first five steps. 



Step 6

Highlight the link with which you want to associate a text string.  
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Figure 49: "Say a sentence" association process, second page element selection

Notice the highlighted link contains the text, “This is yet another sample link.”  The Behavior window shows an event associated with the link because there is already a behavior associated with the link (the first five steps of this process describe how to associate this behavior).



Step 7

From the list of behaviors, select the behavior named Conversa – Say a sentence.
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Figure 50: “Say a sentence” association process, second behavior selection

When you select this behavior, the following window appears (refer to Figure 42 for an enlarged version of the window):
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Figure 51: “Say a sentence” association process, second behavior window



Step 8

Enter a text string in the text box provided and click OK (if you want to change the JSML properties of the text string, do not click OK until after you adjust the JSML values).  Figure 52 shows the behavior window before OK is clicked:
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Figure 52: “Say a sentence” association process, second file name specification

Figure 52 shows the behavior window after a text string has been entered, but before OK is clicked; the text string is “You clicked on the link.”.  If you want to change the JSML properties of this text string, follow the directions listed in the section named Insert PlayTTS Meta (though that section describes a META element instead of a JavaScript behavior, the JSML instructions are the same).



The second behavior uses the onClick event; Dreamweaver assigns this event to every new behavior by default.  Therefore, this process is complete after eight steps.  When the process is complete, you will see a screen that contains the same information as the image in Figure 53.
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Figure 53: "Say a sentence" association process result

Conversa – Say random sentence

This behavior allows you to specify multiple text strings that are selected at random and played when a specific event occurs.  When you select this behavior, you will see the same screen that is displayed in Figure 19.  The following process describes how to associate two text strings with the image in the sample Web page.

Step 1

Click on the image with which you want to associate a collection of text strings.  
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Figure 54: “Say random sentence” association process, image selection

Notice the highlighted image has three small boxes around its lower right perimeter; additionally, the title of the Behaviors window contains an <img> tag (this tag verifies the fact that you selected an image within the Web page). 



Step 2

From the list of behaviors, select the behavior named Conversa – Say random sentence.
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Figure 55: “Say random sentence” association process, behavior selection

When you select this behavior, the following window appears (refer to Figure 19 for an enlarged version of the window):
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Figure 56: “Say random sentence” association process, behavior window



Step 3

Enter a text string in the text box provided and click the Add button.  
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Figure 57: “Say random sentence” association process, file name specification

Figure 57 shows the behavior window after two text strings have been added.  These text strings are “First text string” and “Second text string.”  For more information about adding text strings to the list of strings, refer to the section named Insert Random PlayTTS Meta.  



Step 4

After you have filled out the list of text strings, click OK to proceed.  Figure 58 (shown below) illustrates what the screen will look like after you click OK.
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Figure 58: “Say random sentence” association process, text string list completed

As you can see in Figure 58, the modified image is still highlighted.  You can also see that a behavior is now associated with this image; the Behaviors window lists all of the behaviors associated with a specific page element.  By default, the onMouseDown event is associated with images; the list of possible event handlers is shown below as Figure 59:
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Figure 59: "Say random sentence" association process, list of events



Chapter 4 - Conversationalizing the Internet

This section describes the purpose behind the conversation.  Before you start using the ToolKit, you need to understand what the ToolKit is meant to do.  The conversation concept is unique within the software industry; therefore, this chapter provides the necessary background information to get you interested in creating conversations of your own.

What is a Conversation?

This section explains the concept of the Internet-based conversation by answering two questions:

· What is a “conversation” in the context of the Internet?

· How can a conversation improve a Web site?

As you read the answers to these two questions, you will develop an understanding of the potential function of the ToolKit.

The conversation concept

When two people talk to each other, an exchange of information takes place.  This exchange is called a “conversation,” a term that is typically used in the context of people talking to other people.  Human beings have conversations every day: we talk about the weather, the news, and everything else in our lives.  It is important to remember how humans speak to each other as we move into the realm of human/computer interaction.

The most basic conversation consists of two people: one person speaks while the other person listens.  When the speaker has finished talking, the roles are reversed as the speaker becomes the listener.  Of course, this basic level of interaction is a vast oversimplification.  In real life, people interrupt each other; discussions diverge into new areas, sparking different topics of conversation.  Surprisingly, this natural style of interaction can occur between a person and a computer that is connected to the Internet.  The Conversa' Web ToolKit makes this interaction possible.

An Internet-based conversation is quite similar to a conventional conversation.  The difference lies in the participants: instead of two people communicating, an Internet-based conversation involves a person and a computer.  The conversation itself does not change; an exchange of information still occurs between the person and the computer.  However, the computer is able to provide answers to nearly any type of question because it can draw upon the resources found on the Internet.  And because the computer can carry on a conversation, the answers that it finds on the Internet are communicated in human terms.  You could discuss the weather with your computer, but the conversation would retain the person-to-person style of a typical conversation.

This scenario is possible thanks to the Conversa' Web ToolKit, a software application that makes conversation creation possible.  Using the ToolKit, you can “conversationalize” an existing Web site.  The Conversa' Web browser is the application that allows you to talk to these conversationalized sites.  Conversa' Web comes packaged with the ToolKit; once you have the ToolKit, you do not need to buy any extra software.

The “conversationalized” Internet

The Conversa' Web browser performs the same function as a traditional Web browser (such as Microsoft Internet Explorer).  However, Conversa' Web also allows users to access the function provided by “conversationalized” Web sites.  A conversationalized Web site is a site that has been enhanced to allow vocal navigation.  Instead of relying on the traditional “point-and-click” style of browsing, conversationalized Web sites allow users to navigate using their voice as an alternative to using a mouse.

For example, imagine a Web site that sells products at auction.  If this site was enhanced to allow voice navigation, you could simply say which items you would like to buy.  The Web site would return search results in the form of audible sentences, not just as a display of unsorted information.  You could continue the conversation by asking for more information about a specific item for sale.  When you finished using the auction Web site, you could shift the conversation onto a different Web site.  As the human participant, you would have command over the conversation.

This example is quite simple, both as an application of a conversation-enhanced Web site and as a conversation in general.  However, this example is also important to understand because it conveys the intent behind the conversationalized Internet.  Nearly every site currently provides information in a format that is optimized for the computer, not for the person using the computer.  The Conversa' Web ToolKit provides the utilities to optimize Web sites for spoken commands and questions, the basis of human conversations.  As a Web developer using the ToolKit, you can optimize your sites for a human audience.

Why conversationalize?

Using the Internet is not as easy as it should be because it is not intuitive from the human point of view.  The Internet is based on a global network of computers in communication with each other.  As we try to access this network, we find that the rules of communication are optimized for the machines, not for the people who operate them.  Using the Internet becomes much easier when the machines are programmed to communicate on human terms, through spoken and aural interaction.

A conversationalized Web site is a site that has been enhanced for voice interaction.  However, a Web site is truly “enhanced” only if the people visiting the site benefit from the alteration.  In order to understand the benefits that conversations add to a Web site, consider the following problems that novice Internet users currently face:

· Interacting with many Web pages is not intuitive; you must phrase questions using the syntax of the software instead of speaking naturally

· Typing and pointing is slower than talking

· Learning how to use the Internet takes time; the initial learning curve stops some users from continuing to use the Internet

· Repeatedly receiving incorrect responses after performing a search for information is extremely frustrating
How does a conversationalized Web site address these problems?  The following sections examine these problems individually, starting with the need for intuitive browsing.

Making the computer listen on our terms

If a conversationalized Web site is going to appeal to a novice computer user, the vocal interaction between the person and the computer must be intuitive for the person.  In other words, you should not have to alter your style of speaking to accommodate the computer’s style of information processing.  In the auction example described earlier in this chapter, the conversation with the Web site occurs on the user’s terms; the person is in control of the situation.

Currently, Internet users must construct their questions in terms the computer will understand.  For example, if you want to obtain a weather forecast over the Internet, many sites ask you to input a ZIP code.  But if you are a business traveler who is about to fly to Atlanta, you might not know the ZIP codes for Atlanta.  In this case, the user interface for this Web site is not optimized for the user; the business traveler will become frustrated with the site and will most likely go elsewhere for weather information.

The Conversa' Web ToolKit helps you design a conversation that caters to human users, not to a software program.  The Conversa' Web application is flexible enough to allow natural speech; you can converse with a computer as if you were talking to another person.  When a business traveler requests a weather forecast from a conversationalized Web site, the traveler would simply ask, “What will the weather be like in Atlanta tomorrow?”  The conversational interface makes the Web site much more user-friendly, a benefit that could convince the business traveler to return to the site in the future.

Speaking versus clicking

Most Web sites are currently designed for mouse users; links are there to be clicked, and information is presented visually.  The few sites that include sound as part of the content offer extremely limited capabilities for human interaction.  For example, a song might play when you load a certain Web site, or a voice might welcome you to the site.  These sound events are examples of one-way communication: as the user, you are not able to tell the Web site which sound you want to hear.  This disparity illustrates why the Conversa' Web ToolKit is different from any other development tool on the market.  With the ToolKit, you can design your Web site to interact with its visitors based on their spoken input.

Learning how to use the Internet

When you use a computer for the first time, you are forced to adapt to the software that runs the machine.  For example, a certain keystroke combination will open the Start menu in Windows 95.  However, you do not initially decide which keys will open this menu.  You are forced to adapt to the computer; you must use the predefined keystroke combination to open this menu without a pointer device.

Using the Internet involves a similar learning process.  When you click on a link and discover the associated page cannot be found, you get frustrated.  While every computer user feels this frustration, the feeling is intensified when you are unsure how the Internet works, or whether you are even pressing the correct button on your mouse.  Novice computer users are particularly sensitive to these situations, especially when they know how many people in the world are successfully using the Internet.

If the Internet were entirely conversationalized, if every Web site could communicate with its visitors, this learning curve would disappear.  Using their own words, novice computer users would be able to ask for an explanation of a dead link.  There would be no barriers denying access to the full functionality of the Internet because the information retrieval would occur from the human perspective.  You would not have to learn computer-specific commands in order to use the Internet.

Getting the information you want

One of the biggest problems facing Internet users is accurate information retrieval.  For example, imagine you are having trouble with your printer.  The cause of the problem appears to be related to the printer cable, but you are not sure what to do.  You decide to visit the printer manufacturer’s Web site for troubleshooting information.

Computer peripherals, such as printers and modems, are complex devices that can malfunction in a variety of different ways.  Therefore, it is difficult for a novice computer user to solve a problem when the solution is buried deep within a Web site.  But if the Web site is conversationalized, nearly anyone can find the appropriate information more quickly.

If the troubleshooting portion of a Web site was conversationalized, you could navigate through the maze of information using your voice.  In addition to providing more intuitive links to relevant information, this type of conversation could also eliminate the need to look at the monitor.  For example, if you have to crawl under your desk to check the printer connection, you could continue to talk and listen to the Web site.  Conversations provide an unparalleled level of flexibility, both in information retrieval and in ease of use.

Appendix

Appendix A is a troubleshooting guide.  

Appendix A - Troubleshooting

· Troubleshooting information
· Reiterate contact/documentation location information specific to this section
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